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Introduccion

iBienvenidos a Amberlight!

Amberlight es una herramienta de arte Unica que le permite crear hermosas imagenes
generadas por la computadora. Millones de particulas estan volando a través del lienzo y se
pueden llegar con los campos especiales de Amber. No importa si usted es un artista avanzado
o un novato de arte completo, jugando y experimentando con herramientas usted es capaz de
crear imagenes fantasticas. En el mundo del arte de la computadora, Amberlight es una
herramienta Unica que amplia sus horizontes artisticos y le presenta una nueva experiencia
artistica.

Amberlight 2 tiene muchas caracteristicas innovadoras incluyendo el modo de animacién
avanzado, modificadores y variaciones. De ahora en adelante, los usuarios pueden dar vida a
sus obras de arte y crear animaciones perfectas guardadas como secuencias de video o imagen.

Igual que Flame Painter, Amberlight fue creado originalmente como un proyecto experimental
en mi serie 'Yo soy un artista”. La visidn inicial era crear una aplicacién en la que cualquier
persona podria crear obras de arte originales. Fue hecho tanto como una herramienta para los
artistas, asi como para las personas sin habilidades artisticas que quieren crear algo Unico.

La falta de inspiraciéon y motivacién a menudo son las razones por las que las personas no son
creativas, sin embargo, las herramientas que utilizamos pueden llegar a ser la inspiracién para
la creatividad. Creo que con las herramientas que te inspiran, todo el mundo puede ser artista.

Este manual describe las caracteristicas de la aplicacion y le dice lo que necesita saber para
usar Amberlight y encontrar una nueva manera creativa de la auto-expresion.

Gracias por comprar Amberlight. jEspero que pase un gran tiempo con la pintura!

Peter Blaskovic
Creador de Amberlight



Tabla de Contenido

INEFOTUCCION <.ttt ettt e et e s b e e e bt e e sabe e e e abee e eabeeesabeeeenneesnns 2
EMPBZAMOS «.oeeiiiiiiiee ettt e e ettt see s e e e e et e taaa e s s e e eeseessstaasseeeeeeaesssannseeeesseesrnnnnnseseeeseerssnnnnnnns 5
Instalar y Registrar AMbBErlight.........oooueiiiiiiiii e e 5
Interfaz de AMDEITIZNT ...c...eeeeeee e e e e e e tae e e e e aba e e e e e nraeeeenns 7
Panel de ESCeNa (SCENE PANEI) .....uiiiiiieeiie ettt ettt ee et e e e e e e e nane s 8
Panel de Pardametros (Parameters Panel) ........cocueeeiveeeiiiecciee et 8
Panel de Modificadores (Modifiers Panel).........eeiiiiiiiiiieiieeieieiieeeee et 9
Variaciones (Variations) ...uueeeccueeeeieciiee e eeieee et ee e st ee e et e e s s ra e e e e s e e e e ssabaeeesennaeeeennnaaeaean 9
(013 Te X ALV 1Y=) TSRO 9
Panel de Curva de Contraste (Contrast Curve Panel) ......ccccoecuveeiiiiieee e 10
Panel de Filtro (FIEEr PANEl) ....cccuvvveeiiiiiieiiieeeeee ettt e s esaab e 10
Panel de Navegador (NaVigator Panel) ......ocueeee et 10
Panel de Paleta (Palette Panel) ...ttt e s 11
Panel de Capas (Layers Panel).......ceiiiiiie ittt e e st e e e aae e e s e e e e 12
Panel de Linea de Tiempo (Timeling Panel) ......coccuiieeoiiieeiciiee et 12
Editar Campos (Edit FIEIAS)....cciicueiee ittt e et e e et e e e et e e e e e earae e e s enaaeeeenns 14
Barra de MenU (The IMENU Bar) ....uuveeeeieiiieiciieeeeee ettt e st ree e e e e e e e esarareeeeeeeeeennnrseneees 16
MenU de Archivo (FIlE IMENU)......uvvieiiiii ettt e st e e e s e s s esaasbaeeeees 16
MenU de Editar (Edit IMENU)........uuviieeieee ettt e e e e st e e e e e e e e e ennnraeneees 18
MeNU de ESCENA (SCENE IMBNU) ..uvvvviiiiiiiieiiirieeeee ettt e e e e e s sbbbr e e e e e s e s s ennasbaereeas 18
MenU de Filtro (FIEEr IMENU).......uiriieeiee ettt e e e e st e e e e e e e e e ennnrneneees 19
MENU de Vista (VIEW IMENU)...coeeiiiiieiei ettt eesbbare e e e s e e ssabataereeesessennnbaenenes 19
Menu de Ventana (WIindOW IMENU) ......oooiiiiiiiiee ettt e e e e e arreee e e e e e e eenanneeees 19
Menu de Ayuda (HEIP IMENU) ......uueiiieeeee ettt ettt e e et e e e et e e e e e aa e e e e e eaneeas 20

FA 01T 4 F=Toi o o PR TP PP PR RUPPRTPPP 21
1. Crear NUEVA ESCENA......ccuiiiiiiiiiiiiiicc e e 21
2. Velocidad de Reproduccién y Repeticidn de Reproduccion .........ccccveeeeeeeieicciiiieeeeeeeeeeeans 22
3. Trabajar CON LiNEa d€ TIEMPO c.uuurrieiieeeeiieiitieeeee e e e eececttrree e e e e e e sesabrereeeeeeeesssssseeseeeeessennnes 23
4. Animar Campos (EJemMPlo SIMPIE) ...eeieeiiiee et e e e 24



5. Experimentar CON MoOdifiCA0OIES....uuiiiiiiiieiirieeeiec ettt e e eeseaarrereeeeeeseenanes 27

6. Interpretar Vista Previa de ANIMaCiON ....cc.uviviiiiiiiie it 29
7. INterpretacion FIN@l.... ..ot e e e e e e e e et e e e e e aaa e e e e e ntaeeeenns 29
Crear, Cargar y GUArgar ESCENAS .....cuuuiiiiiiiiiiiiiiiiieieitttteteeeeeteeeeereeereeeeereeeeeeereeerereeereeeseeererereeeeareees 33
Crear NUEVA ESCENQ........uiiiiiiiiii it e s s sae e 33
LY o] Yol T o - TP PP UP R TRRT 33
GV T de E T o= o - T PP P PP P PP OPUPPPPRRPPON 33
(@Y T Vo] [oF= Tl o TP SPRSSPN 34
PUblicar IMagen @ Galeria.......oouuiiie i e s sae e e e s e e e e s eaaeeeeenans 35
Crear UNa Cuenta de GalBria .....c.eooueieieeieeeieee et seee e 35
Publish image from Amberlight to Gallery........coooueeeiiiciiie e 35
Editar su perfil y imagenes en 1a Galeria.......coeeoecieiee e 35
JAN o Tye [ =Tl - Yo o T PRSP 36
Derechos de AULOr Y Créditos .......eiiieiiiiie ettt e et e e e e e e e e ar e e e e e saaaeeeseneeeeeenns 38
Amberlight End-User Software License Agreement ........occveeeeeiiieeeeriiiee e ceieeeeesree e sreee e e 39



Empezamos

Instalar y Registrar Amberlight

Descargar & Instalar

Después de comprar Amberlight desde nuestro sitio web, recibird el correo electrénico con un
enlace para descargar y con detalles para registrar.

Usuarios de Mac OS X
Descarga un archivo .dmg del enlace que aparece en un correo electrénico. Localice el archivo

de instalacidon de Amberlight 2 llamado "Amberlight_2.1.dmg". Haga doble clic en el archivo de
instalacidn para completar la instalacion.

Usuarios de Windows

Descarga un archivo .zip file from link provided in a registration email. . Localice el archivo de
instalacion de Amberlight 2 llamado "Amberlight 2.1.zip”. Extraiga el archivo .zip y haga doble
clic en el archivo de instalacion .exe para completar la instalacion.

Registrar

Introduzca sus datos para registrar desde el correo electrdnico. Por favor, compruebe si estd
conectado a Internet, se requiere la conexidn a Internet para la activacién para comprobar los
datos de registro.

SUGERENCIA: Le recomendamos copiar & pegar su Clave de Registro e ID para evitar la falta de
ortografia.

Iniciar la Aplicacion

Vera un “Intro Tutorial” durante el primer inicio de la aplicacién, o después de cada
actualizacidn a la versidon mas reciente. Este tutorial le guiard a través de las herramientas mas
esenciales de Amberlight. Puede abrir este “Intro Tutorial” desde Menu -> Ayuda (Menu ->
Help) en cualquier momento.



Requisitos del Sistema

Intel o AMD procesador, tarjeta grafica Open GL 2.0, 1GB RAM, espacio de disco duro de 40

MB, Windows 7, 8, 10, o Mac OS X 10.8 y mas nuevo.

Obtener Soporte para Amberlight

Si necesita ayuda para utilizar Amberlight, en primer lugar consulte el manual incluido. Hemos
intentado hacerlo facil para leer y lleno de informacién que necesita saber.

Le invitamos a enviarnos un correo electronico a support@escapemotions.com si usted tiene
cualquier pregunta, problema técnico con Amberlight, o le gustaria simplemente para
saludarnos.

Antes de hacer preguntas por favor lea la FAQ en ‘support’ seccion en el sitio web
http://amberlight.escapemotions.com en primer lugar. Si la respuesta no esta ahi, por favor
agrega la configuracion de su equipo a su correo electrénico (Windows / Mac OS, 32 / 64 bits
del sistema operativo, procesador, tarjeta grafica, memoria). Esto nos ayudara a proporcionar
respuestas mucho mas rapido.

Comunidad
Sigamos en contacto en nuestros canales sociales - haga clic en cualquier icono y visitar

nuestras paginas en Facebook, Twitter, Pinterest, Google+, Tumblr, YouTube, DeviantArt,
Behance y Instagram.

HUREHAEE


file:///C:/Users/Ada/Dropbox/Escape%20Motions/!_Amberlight%202/manual/_Manual/2.1/SPANISH/support@escapemotions.com
https://www.instagram.com/escapemotions
https://www.facebook.com/flamepainterpage?ref=hl
https://www.behance.net/escapemotions
http://escmot.deviantart.com/
https://www.youtube.com/user/EscapeMotions
https://www.tumblr.com/blog/escapemotions/
https://plus.google.com/u/1/b/109066869359827919028/109066869359827919028/posts
http://www.pinterest.com/escapemotions/
https://twitter.com/escapemotions

Interfaz de Amberlight
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1 - Ventana Gréfica (Viewport)

2 - Panel de Escena (Scene Panel)

3 - Panel de Pardmetros (Parameters Panel)

4 - Panel de Modificadores (Modifiers Panel)

5 - Panel de Curva de Contraste (Contrast Curve Panel)
6 - Panel de Filtro (Filter Panel)

7 - Panel de Navegador (Navigator Panel)

8 - Panel de Paleta (Palette Panel)

9 - Panel de Capas (Layers Panel)

10 - Panel de Linea de Tiempo (Timeline Panel)

Esto es la Interfaz predeterminada de Amberlight. Puede cambiarla de acuerdo a sus

necesidades.

SUGERENCIA: Todos los paneles son acoplables - es posible modificar, cambiar de posicion y
ajustar la anchura de los paneles.



Panel de Escena (Scene Panel)

Fields 4 @ © @ edic °,»

@ Render

Campos - Establezca el nimero de campos (fields): (1-12).
@/@ - Agrega o reduzca campos seleccionados.
@ Editar - Cambie al modo de Editar los campos.

[ ]
«* Random - Escena y campos aleatorios.

@ Interpretar - Interprete el cuadro actual.

@ Interpretar animacion - Interprete la previsualizacion
de animacion.

Paso - Establezca el nUmero de pasos de interpretacion -
iteraciones. Si desea tener una escena renderizada suave,
ajustela en 10.000. Si necesita una calidad de impresion,
establezca un nimero mas alto.

X Utilizar valor actual - Utilice el valor del Paso como
valor final.

Raster - Seleccione el valor de raster (1-8). Establezca
raster a valores mas altos para propdsitos de vista previa,
la interpretacion serd mas rapida.

Panel de Parametros (Parameters Panel)

Position X
Position Y

Force

Intensiky

Cuk-off

Posicion X - Ajuste la posicién X del campo.
Posicion Y - Ajuste la posiciéon Y del campo.
Fuerza - Ajuste la fuerza del campo.
Intensidad - Ajuste la intensidad del campo.
Cierre - Ajuste el cierre del campo.

Puede encontrar mas informacién sobre los parametros
de los campos en la seccidn ‘Editar Campos (Edit Fields)’

mas adelante en el manual.



Panel de Modificadores (Modifiers Panel)

Experimente con los modificadores del campo y manipule el aspecto final. Los modificadores se
dividen en:

Variaciones (Variations)

Hay dos typos de variaciones a elegir:

Type Random - Los campos crearan formas y formaciones
Mumber aleatorias.

Scale 10 Uniforme - Los campos crearan formas y formaciones
uniformes.

Type

Numero - Seleccione el nimero de variaciones (1-50). El

Frequency , p L ,
numero afecta cuantas variaciones se crearan en la

Amplitude

escena.

Escalar - Escale los variaciones (1-100). La escala afecta la
posicién de cada variacion. Cuando la escala es menor, las
variaciones se acercaran mas cerca la una a la otra.
Cuando la escala es mayor, las variaciones se haran mas
lejos.

Onda (Wave)

Onda (Wave) es el modificador que afecta el aspecto final.
Hay cinco typos de onda a elegir:

Ningun - No se utiliza ningun modificador de onda.
Circulo - Onda circular.

Cuardado - Onda cuardada.

Vertical - Onda vertical.

Horizontal - Onda horizontal.

Frecuencia - Establezca la frecuencia con la que se
repetiran las ondas en la escena (1-100).

Amplitud - Ajuste la amplitud de la onda (1-100). La
amplitud es la mitad de la distancia entre los valores
minimo y maximo de la onda.



Panel de Curva de Contraste (Contrast Curve Panel)

Hay tres ajustes de contraste diferentes:

Base - Establezca la base de la curva de contraste -
sombras (1-100).

Pico - Establece los picos de la curva - highlights (1-100).
Limite - Establece el limite del pico de la curva (1-100).

Panel de Filtro (Filter Panel)

Parametros de Filtro a experimentar:
Alpha Mask Mascara Alfa - Opacidad de la Imagen (0 - 100).
Tink Tinte - Active o desactive el gradiente de tinte, rote tinte
: y ajuste color y radio de tinte (0 - 100).
Glow Brillo - Active o desactive efecto de brillo (glow).

Radio - Ajuste radio de brillo (0 - 100).

Fuerza - Ajuste fuerza de brillo (0 - 100).

Panel de Navegador (Navigator Panel)

Q Reducir - Reduzca la vista de la escena (a un tamaiio
minimo de 5%).

Q Aumentar - Aumente la vista de la escena (a un
tamafio maximo de 2000%).

Control de Zoom - Ajuste el zoom utilizando el control de
zoom (1 - 2000%).

Q Restablecer Zoom - Compruebe el valor de zoom
aqui. Pulse el botdn para restablecer el zoom al 100%.

(-] Encajar en Pantalla - Encaje la escena en la pantalla.
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Panel de Paleta (Palette Panel)

Elija y ajuste su transicion del gradiente para la escena.
Haga clic en el botdn de color que desea cambiary
seleccione el color de la paleta. Puede activar / desactivar
el color que desea utilizar en el gradiente.

o el ]
|| u [l E]

o' Paleta - Abra la paleta de colores del sistema.

“*B Gradiente a Blanco - Cambie la transicién del
gradiente al color blanco.

"*[J Gradiente a Negro - Cambie la transicién del
gradiente al color negro.

o Voltear - Voltee el gradiente.
(B Invertir - Invierta los colores en el gradiente.

(d] Mover - Mueve los colores del gradiente a la derecha.

H | S| L- Cambie Matiz, Saturacién y Luminancia para
todos los colores en el gradiente.

Paleta - Seleccione el color.

Conjunto de colores - Una paleta del conjunto de colores predeterminado. Puede agregar
colores personalizados - se guardardn para un proyecto futuro aun cuando una aplicacidn estd
cerrada.

@/@ - Agrega y elimina colores personalizados desde Conjunto de Colores.

Gradientes - Seleccione un gradiente desde la Lista de gradientes.

@/@ - Agrega y elimina gradientes desde la lista.

Para utilizar un color monocromatico en lugar de un
gradiente, establezca el primer color del gradiente a color
negro, el medio a color que desea utilizar y el dltimo a
color blanco.
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Panel de Capas (Layers Panel)

p—— Utilice la ventana del Panel de capas para editary

Blending 'Mormal manipular con capas.

Opaciky 100
Fusion - Modo de fusion de la capa.
Opacidad - Ajuste la opacidad de la capa. (0-100).

@ .. Amberlight 100

@ Image 100 ® Ojo - Muestra u oculta la capa activa.
Color de Fondo - Muestra u oculta Color de fondo y
seleccione el color.

@® Background Color

(1) ) Para guardar una escena con fondo transparente, oculta

el color de fondo haciendo clic en el icono “Ojo” y
guardelo como .png.

[T.l Importar Imagen - Importe la segunda imagen para la
composicion.

@ Limpiar Capa - Limpie la capa de Amberlight o la capa
de imagen.

Panel de Linea de Tiempo (Timeline Panel)
Utilice el panel Linea de tiempo para crear animaciones, editar y manipular marcos y claves.

Playback Range Start Time Playback Range End Time

Time Slider Current Frame Playback Controls
I

Kt |4 4 [B] » M W

o O |Auto key [AllFields| B

N . . N ) Auto .
Animation Start Time Range Slider Animation End Time Keyframe Scene Settings
Rendered Range Selection Add Keyframe Keyframe All Fields
Current Frame Keyframe Remove Keyframe

Inicio de Rango de Reproduccién (Playback Range Start Time) - Establezca el tiempo de inicio
de rango de reproduccién. Puede cambiarlo introduciendo un tiempo de inicio nuevo.

Si introduce un valor que es mayor que Final de Rango de Reproduccion, Inicio de Rango de
Reproduccidn se desplaza a una unidad menos que Final de Rango de Reproduccién.

Final de Rango de Reproducciéon (Playback Range End Time) - Establezca el tiempo final de
rango de reproduccién. Puede cambiarlo introduciendo un tiempo final nuevo.
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Si introduce un valor que es menor que Inicio de Rango de Reproduccion, Final de Rango de
Reproduccién se desplaza a una unidad mas que Inicio de Rango de Reproduccién.

Inicio de Animacion (Animation Start Time) - Establezca el nimero del primer fotograma en la
animacion.

Final de Animacion (Animation End Time) - Establezca el nimero del ultimo fotograma en la
animacion.

Fotograma Actual (Current Frame) - El cuadro indica el fotograma actual. Puede cambiar el
fotograma actual introduciendo un nuevo valor.

Control de Rango (Range Slider) - Ajuste el rango de reproduccion.

Control de Tiempo (Time Slider) - Controle el rango de reproduccion, las claves y las
selecciones dentro del rango de reproduccién.

Rango Interpretado (Rendered Range) - La linea verde indica fotogramas, que ya se han
interpretado a través de la funcidn 'interpretar animacion'.

Seleccion - Seleccione varias claves para copiar, cortar, pegar o eliminar.

Controles de Reproduccion (Playback Controls):

¥4 | al Inicio (Go to Start) - Vaya al inicio de rango de reproduccion.

M Fotograma Clave Anterior (Previous Keyframe) - Vaya al fotograma clave anterior.

< Fotograma Anterior (Previous Frame) - Vaya al fotograma anterior.
E] Reproducir (Play) - Reproduzca la animacién. Play the animation. Cuando la animacién se
esta reproduciendo, el botéon cambia al botén Detener (Stop) @

> Fotograma Siguiente (Next Frame) - Vaya al fotograma siguiente.

M Fotograma Clave Siguiente (Next Keyframe) - Vaya al fotograma clave siguiente.

"1 | al Fin - Vaya al fin de rango de reproduccion.

O Agregar Fotograma Clave (Add Keyframe) - Agrega un nuevo fotograma clave.

€ Eliminar Fotograma Clave (Remove Keyframe) - Elimina fotogramas clave seleccionados.
Fotograma Clave Automitico (Auto Key) - La clave se creard atomaticamente en el fotograma
actual. Desactive si desea agregar fotogramas clave manualmente.

Todos Fotogramas (All Fields) - Las claves se creara para todos los campos en la escena.
Desactive si desea agregar fotograma clave sélo para el campo seleccionado.

B Ajustes de Escena (Scene Settings) - Abra ajustes de la escena.
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Editar Campos (Edit Fields)

Pulse el botdn Edit / Editar en el Panel de Escena o el Botdn lzquierdo del Raton sobre la
escena para editar campos. Puede ajustar el nimero de campos en el Panel de Escena desde 1
hasta 12. Cada campo estd representada como un circulo con la posicion X, Y y 3 parametros.
Con estos parametros se puede establecer como los campos influirdn las particulas.

Parametros de Campos (Field parameters)

Posicion Central (Center Position) - (A) - Pulse LMB
(left mouse button - botdn izquierdo del ratén) en un
circulo central del campo y establezca la posicidn del
campo en una escena. Puede configurarlo
manualmente en el panel Pardmetros, donde puede
introducir valores para la Posicién X y la Posicidn Y.

Fuerza (Force) - (B) - Pulse LMB en un botén y
establecza la fuerza del campo con el movimiento a
izquierda o derecha. A la derecha desde el centro, el
campo tiene fuerza positiva (+), a la izquierda desde el
centro tiene la fuerza negativa (-). Puede configurarlo
manualmente en el panel Pardmetros.

Intensidad (Intensity) - (C) - Pulse LMB en un botéony
ajuste la intensidad del campo con el movimiento
arriba y abajo. Distancia desde el centro establece el

valor de la intensidad. Arriba del centro es mas alta 'y
abajo del centro es mas baja. Con este parametro se

cambia la intensidad de la influencia del campo sobre
las particulas. Puede configurarlo manualmente en el
panel Parametros.

Cierre (Cut-off) - (D) - Pulse LMB en un botdn y ajuste
el cierre del campo con el movimiento abajo desde el
centro del circulo. Distancia desde el centro del
circulo establece la distancia, donde las particulas
parardn desde el campo. Puede configurarlo
manualmente en el panel Pardmetros.

14



Trabajar con campos (Working with fields)

Para copiar propiedades del campo seleccionado, use Ctrl + C / Cmd + C o Editar -> Copiar
Propiedades del Campo (Edit -> Copy Field Properties).

Para pegar propiedades al campo seleccionado use Ctrl +V / Cmd + V o Editar -> Pegar
Propiedades del Campo (Edit -> Paste Field Properties).

Para duplicar el campo o campos seleccionados, use Ctrl +D / Cmd + D o Editar -> Duplicar
Campos (Edit -> Duplicate Fields).

Seleccione todos campos usando Ctrl + A/ Cmd +A o Editar -> Seleccionar Todos Campos (Edit
-> Select All Fields).

También puede seleccionar los campos haciendo clic y arrastrando para desplazar, escalar o
rotar los campos seleccionados.

Use Shift para sélo desplazar los campos y Control / Cmd para sélo rotar los campos.
El centro de la rotacidon se muestra como simbolo (+). Puede colocar el centro en cualquier

lugar de la escena haciendo clic y arrastrando (+) a la posicién deseada.

Vea cuadriculas para posicionar los campos mas precisamente a través del menu Escena ->
Ajustar a cuadricula (Scene -> Snap to Grid). El centro del campo, el centro de seleccién y los
fotogramas clave se ajustan a la cuadricula.

Puede configurar el nUmero de cuadriculas en el Panel de Preferencias.
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Barra de Menu (The Menu Bar)

Archivo (File) - Contiene acciones relacionadas con cargar, guardar, exportar y publicar sus
imagenes.

Editar (Edit) - Contiene acciones relacionadas con herramientas de edicién y campos.
Escena (Scene) - Contiene acciones relacionadas con herramientas de edicion, la escenay
interpretacion.

Filtro (Filter) - Contiene acciones relacionadas con los filtros de imagen.

Vista (View) - Contiene acciones relacionadas con la ventana gréfica.

Ventana (Window) - Contiene acciones relacionadas con los paneles y la interfaz de usuario.
Ayuda (Help) - Contiene acciones que permiten obtener ayuda de la aplicacion o buscar
actualizaciones en la pagina web.

Menu de Archivo (File Menu)

El Menu de Archivo contiene acciones relacionadas con su escena de la siguiente manera:
Nueva... - Abre un cuadro de didlogo que le permite crear una nueva escena con los nuevos
ajustes.

Puede establecer la anchura y la altura de la nueva escena en pixels, centimetros o inches, la
velocidad de la reproduccion en cuadros por segundo (FPS), repeticion de la reproduccidn,
color del fondo y una DPI de la imagen:

e =090 e

Image Size; Image Size Info;

widkth:

Height: 1

Play

Cusktom...

Cineon Full, 3656
Cinemasd

HODTY

HOTY

HOTV

HDW 10

Ultra HD

Film (
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También puede elegir entre variedad de ajustes de tamafio de la escena o agregar / eliminar

ajustes preestablecidos usando los botones @/G)

Abrir... - Abre el cuadro de didlogo que le permite cargar una escena desde disco.

Abrir Reciente - Abre una de las ultimas escenas guardadas.

Guardar... - Guarde su escena en formatos amb, .png, .jpg, .bmp y .tif. Si no ha guardado
anteriormente, se le pedira que introduzca el nombre.

Guardar Como... - Guarde una copia de su escena actual como una nueva.

Importar Imagen... - Importe una imagen en formatos .png, .jpg, .omp vy .tif a la Capa de
Imagen. La imagen se redimensiona al tamafio real del lienzo, pero se puede cambiar a
cualquier tamafio. Pulse Enter para confirmar o Esc para cancelar.

Exportar Imagen... - Exporte una imagen en formatos .png, .jpg, .bomp y .tif desde Amberlight.

Publicar... - Publique su imagen en la Galeria de Escape Motions.

Preferencias de Publicar... - Introduzca Sunombre, Email (“Your ID”) y Contrasefia a la Galeria 'y
opcionalmente el enlace a su Sitio web.

Obtenga mds informacion sobre las opciones de publicacidn en la Publicar Imagen a Galeria
seccion.

Preferencias ... - Ajuste Preferencias General y del Teclado.

- General - Startup Screen - Mostrar cuadro de dialédgo de "Nueva Escena" al inicializacién
de la aplicacién - Marque esta opcidn si desea que el cuadro de didlogo Nueva
Escena se abre cada vez que inicie la aplicacidn.
- Escena - Aumentar al cursor - Marque esta opcion si desea aumentar al cursor
y no al centro de la escena.
- Compresion Jpeg - Establezca la calidad del archivo Jpeg.
- Interfaz - Ajuste la escala para cambiar el tamafio de la interfaz (90-200%).
- Sensibilidad de Box de Editar - Ajuste la sensibilidad de editar del spinbox para
el ratdn o tableta grafica.
- Memoria - Establece la memoria maxima utilizada.
- Cuadricula - Ajuste el nUmero de cuadriculas horizontales y verticales (el
maximo es 100).

- Teclado - Establezca los atajos de teclado personalizados. Haga clic en Restablecer para
restablecer el atajo actual o en Eliminar para eliminar el atajo. Haga clic en
Restablecer Todos para restablecer todos los atajos.

Haga clic en OK para confirmar los cambios realizados en Preferencias o Cancelar, si no lo
desea.

Quitar - Cierre la aplicacidn. (Sélo en Windows).
Para obtener mas informacién sobre cdmo crear, cargar y guardar sus imagenes, consulte la
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seccion ‘Crear, Cargar y Guargar Escenas’ (Creating, Loading and Saving Scene) mas adelante en
el manual.

SUGERENCIA: También puede arrastrar y soltar (drag & drop) una imagen desde cualquier
aplicacion, archivo o navegador de Internet directamente a Amberlight si la aplicacion lo permite.

Menu de Editar (Edit Menu)

Deshacer - Deshace la ultima operacién que ha realizado. NiUmero maximo de pasos para
deshacer es 100.
Rehacer - Rehace la ultima operacién de deshacer.

Copiar Propiedades de Campo - Copie las propiedades de un campo seleccionado. Copy the
properties of selected field.

Pegar Propiedades de Campo - Pegue las propiedades a un campo seleccionado.

Duplicar Campos - Duplique el campo o los campos seleccionados.

Seleccionar Todos Campos - Seleccione todos los campos en la escena.

Menu de Escena (Scene Menu)

Ajustes de Escena... - Abre un cuadro de didlogo que le permite establecer un tamario de la
escena. Puede seleccionar si desea Mantener aspecto original (Keep aspect ratio) de la escena
y si quiere Escalar campos (Scale fields).

Editar - Edite los campos, su posicidn y parametros - Fuerza, Intensidad y Cierre.

Editar Trayectoria - Edite las claves y las tangentes de la trayectoria de animacidn. Cada clave
tiene dos tangentes, una izquierda y una derecha. Moviendo las tangentes de una clave cambia
la forma de la trayectoria de animacion.

Restablecer Tangentes - Restablezca las tangentes al valor predeterminado.

Random - Escena y parametros de los campos aleatorios.

Ajustar a Cuadricula - Utilice la cuadricula para posicionar los campos con mayor precision.
Puede configurar el nUmero de cuadriculas en el Panel de Preferencias.

Recortar - Seleccione el area que desea recortar. El drea recortada se colocara en la escena y
los campos se escalaran en consecuencia.

Interpretar Imagen - Interprete la fotograma actual.

Interpretar Animacion - Interprete la animacién para obtener una vista previa de cdmo se verd
la interpretacion final.
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Interpretacion Final - Interprete la animacion final y guarde en la computadora. Seleccione la
ubicacién, nombre y formato de archivo - como una secuencia de imagenes en .jpg, .png, .bmp,
.tif o como un video en formato .avi, .mov, .mkv o .webm.

Menu de Filtro (Filter Menu)

Tinte - Active y desactive el filtro de Tinte. Ajuste su Color, Rotacién y Fuerza.
Brillo - Active y desactive el filtro de Brillo Ajuste su Radio y Fuerza.
Capa de Azulejos - Cree una capa de azulejos horizontalmente y verticalmente.

Menu de Vista (View Menu)

Aumentar - Aumente la vista de la escena (a tamafio maximo de 2000%).

Reducir - Reduzca la vista de la escena (a un minimo del 5%).

Aumentar al 100% - Comprueba el valor de zoom. Pulse el botén para restablecer el zoom al
100%.

Encajar en Pantalla - Encaje la escena en la pantalla.

Permanecer Arriba - Aplicacion permanecera siempre en la parte superior de otras
aplicaciones.
Pantalla Completa - Cambie la ventana de la aplicacion en modo de pantalla completa.

Menu de Ventana (Window Menu)

Menu de Ventana contiene acciones relacionadas con los paneles y la interfaz:

Escena - Muestre u oculte el Panel de Escena.

Parametros - Muestre u oculte el Panel de Parametros.
Modificadores - Muestre u oculte el Panel de Modificadores.

Curva de Contraste - Muestre u oculte el Panel de Curva de Contraste.
Filtro - Muestre u oculte el Panel de Filtro.

Navegador - Muestre u oculte el Panel de Navegador.

Paleta - Muestre u oculte el Panel de Paleta.

Capas - Muestre u oculte el Panel de Capas.

Linea de Tiempo - Muestre u oculte el Panel de Linea de Tiempo.

Desmarque el panel para ocultarlo de la interfaz de usuario. Compruebe el panel para llevarlo a
la interfaz de usuario.
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Menu de Ayuda (Help Menu)

Ayuda - Abra este Manual de Usuario.

Enviar Comentarios... - Envienos sus comentarios si usted tiene cualquier problema, una idea o
simplemente le gusta el programa. Puede elegir entre 3 tipos de comentarios:

Bravo - ¢ Te gustaria expresar cémo genial Amberlight es?

Idea - ¢ Tiene alguna caracteristica que seria una gran adicion a Amberlight?

Bug - ¢Encontré cualquier comportamiento curioso al utilizar Amberlight?

Introduzca su correo electrénico y mensaje - leemos cada uno. ©

Feedback type:

uls Bravo 3§ Idea % Bug

Email:
email@email.com

Message:

Pagina web de Amberlight - Enlace a la pagina web: http://amberlight.escapemotions.com

Intro Tutorial - Muestra el Intro Tutorial. Este tutorial le guiara a través de las herramientas
mas esenciales en Amberlight.

Acerca de Amberlight - Obtenga un poco de informacion basica acerca de Amberlight,
copyright y créditos. (En Menu de Ayuda sélo en Windows).

Mostrar Carpeta de Biblioteca ... - Muestra carpeta donde se guardan los gradientes.
Buscar actualizaciones... - Este botdn es visible cuando hay nuevas actualizaciones disponibles.
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Animacion
Esta seccidn describe cémo crear animaciones en Amberlight:

Crear Nueva Escena

Ajustar Velocidad de Reproduccién y Repeticién de Reproduccion
Trabajar con Linea de Tiempo

Animar Campos (Ejemplo simple)

Experimentar con Modificadores

Interpretar Vista Previa de Animacion

No vk~ wNRE

Interpretacion Final

1. Crear Nueva Escena

En esta seccion describiremos cdmo crear una nueva escena en Amberlight:

1. Haga clic en Archivo -> Nueva... (File -> New...) y aparecerd una ventana de nueva escena:

© - N =i- =]

Image

width:

Heighk: 1 inches

< LoD FI | n g

Background Color:

Film (2K) , 2045 x 1556 pixels, 24 Fps - Cuskom... -

Film (k)
Cineon Half,
Cineon Full, 3

Cinemasco

Ultra HD

Film
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2. Ajuste la anchura, la altura y DPI de la escena manualmente o seleccione de la lista de
conjuntos preestablecidos de tamano.

3. Ajuste la velocidad de reproduccién en FPS y active / desactive la repeticion (looping) de
reproduccion (mas informacion sobre la velocidad de reproduccién y la repeticion en la
siguiente seccion).

4. Guarde sus ajustes de escena personalizados usando el botdn @

5. Establezca el color de fondo. Elija entre Negro, Blanco o Transparente (Ninguno) o seleccione
su propio color personalizado en la paleta de colores del sistema.

6. Haga clic en OK para confirmar o Cancelar, si no lo desea.

Puede cambiar estos ajustes en cualquier momento durante el trabajo de animacion desde el
menu Escena -> Ajustes de Escena (Scene -> Scene Settings) o directamente desde la linea de

tiempo haciendo clic en el botén Ajustes de Escena %

2. Velocidad de Reproduccion y Repeticion de Reproduccion

Al crear una nueva escena se puede establecer facilmente los valores FPS y la repeticion de
reproduccion. FPS se refiere a cuadros por segundo o cuantos fotogramas se deben dibujar por
cada segundo que pasa en tiempo real. Esta caracteristica es esencial cuando se considera
cuanto tiempo deberia ser el video final de Amberlight. La configuracion de fps recomendada
es entre 25-30 fps, sin embargo esto depende de para qué propésito se utilizara el video.
Establezca la repeticion de reproduccion si desea que el video genere un resultado continuo de
video repetitivo.

Puede cambiar la velocidad de reproduccién y la repeticion antes de Interpretacion final.

SUGERENCIA: Para calcular cudntos fotogramas necesita para su video, piense en la duracion
final del video en fotogramas por segundo (FPS). Si la velocidad de reproduccion estad
establecida en 30 FPS y necesita un video final de 30 segundos, tendrd que crear 900
fotogramas (30 FPS x 30 segundos).
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3. Trabajar con Linea de Tiempo

Utilice el panel Linea de Tiempo para crear animaciones, editar y manipular fotogramas y

claves:
Playback Range Start Time Playback Range End Time
Time Slider Current Frame Playback Controls
Animation Start Ti Range Slid Animation End Ti A0 Scene Setti
nimation Start Time ange Slider nimation End Time Keyframe cene Settings
Rendered Range Selection Add Keyframe Keyframe All Fields
Current Frame Keyframe Remove Keyframe

Ajuste el nimero de fotogramas estableciendo Inicio de Animacion (Animation Start Time) y
Final de Animacién (Animation End Time).

Ajuste manualmente Inicio de Rango de Reproduccion (Playback Range Start Time) y Final de
Rango de Reproduccion (Playback Range End Time).

Haga clic y arrastre el Control de Rango (Range Slider) para moverse por la linea de tiempo.

El Control de Tiempo (Time Slider) muestra el rango de reproduccion y las claves que ha
establecido para los fotogramas seleccionados.

Controles de Reproduccidon (Playback Controls) controlan la reproduccién de animaciones.
Puede reconocer los botones convencionales para reproducir y rebobinar (volver al inicio). El
botdn de detener sdlo aparece cuando se estd reproduciendo la animacién. Para saber qué
operacion representa un botdn, mantenga el puntero del raton sobre él:

k4 |; al Inicio (Go to Start) - Vaya al inicio de rango de reproduccion.

4 Fotograma Clave Anterior (Previous Keyframe) - Vaya al fotograma clave anterior.

€ Fotograma Anterior (Previous Frame) - Vaya al fotograma anterior.
@ Reproducir (Play) - Reproduzca la animacién. Play the animation. Cuando la animacién se
esta reproduciendo, el botdon cambia al botén Detener (Stop) @

> Fotograma Siguiente (Next Frame) - Vaya al fotograma siguiente.

M Fotograma Clave Siguiente (Next Keyframe) - Vaya al fotograma clave siguiente.

"1 ir al Fin - Vaya al fin de rango de reproduccién.

O= Agregar Fotograma Clave (Add Keyframe) - Agrega un nuevo fotograma clave.
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%€ Eliminar Fotograma Clave (Remove Keyframe) - Elimina fotogramas clave seleccionados.

Fotograma Clave Automitico (Auto Key) - La clave se creard atomaticamente en el fotograma

actual. Desactive si desea agregar fotogramas clave manualmente.

Todos Fotogramas (All Fields) - Las claves se creara para todos los campos en la escena.

Desactive si desea agregar fotograma clave sdlo para el campo seleccionado.

B Ajustes de Escena (Scene Settings) - Abra ajustes de la escena.

an l lag  Igp
Copy

Cut
Paste

Delete

Puede manipular con una o varias claves
seleccionadas directamente en la linea de tiempo.
Mueva una tecla con hacer clic y arrastrar.
Seleccione varias claves a la vez haciendo clicy
arrastre o con la tecla Shift.

Mueva o haga clic con el botén derecho del ratén
en la seleccién y elija Copiar, Cortar, Pegar o
Eliminar (Copy, Cut, Paste, Delete) las claves
seleccionadas.

4. Animar Campos (Ejemplo simple)

En esta seccion puede encontrar un ejemplo de una animacién simple. Crearemos animacion

con dos campos:

1. Establezca la posicidn inicial de los campos. El
nuimero predeterminado de campos en la
escena es 4. Agregue o elimine facilmente

campos usando los botones @ / @ en el Panel
de Escena o escriba el nimero exacto en la
seccién Campos. Para editar los campos, haga
clic en el botdn Editar en la Panel de Escena o
haga clic directamente en la escena con el botén
izquierdo del ratén. Puede agregar o eliminar los
campos en cualguier momento durante el
proceso. Puede encontrar mas informacion
sobre la edicién de campos en la seccién ‘Editar
Campos (Edit Fields)’.
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2. Mueva a la fotograma 8 en la linea de tiempo.

3. Seleccione todos los campos con Ctrl + A o los
marque usando multi-seleccién (haga clicy
arrastre).

Mueva los campos a la posicidon deseada.
Cuando Fotograma Clave Automatico (Auto
Key) estd activado, la clave se creard
automaticamente en el fotograma 8.

4. Mueva a la fotograma 15 en la linea de
tiempo.
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5. Haga clic en el campo 1 y muévalo a la
posicién deseada.

La clave para este campo se creara
automaticamente en el fotograma 15.

15
W oo oz s

6. Haga clic en el campo 2 y muévalo a la
posicién deseada.

La clave para este campo se creara
automaticamente en el fotograma 15.

Para ver la trayectoria de animacién de un campo, haga clic en el centro del campo.
Las claves de la trayectoria se muestran como nodos. Puede editar la posicidn de las claves
directamente en la curva.

Para editar las claves y la trayectoria de animacién, vaya a la barra de menu: Escena -> Editar
trayectoria (Scene -> Edit trajectory). Las tangentes en cada clave apareceran. Cada clave tiene
dos tangentes, una izquierda y una derecha. Al mover las tangentes de una clave cambia la
forma de la trayectoria de animacion:

Para restablecer las tangentes al valor predeterminado, vaya al menu: Escena -> Restablecer
tangentes (Scene -> Reset tangents).
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5. Experimentar con Modificadores

Los modificadores le ayudaran a dar forma y cambiar el aspecto final de la escena. Se dividen
en dos grupos: Variaciones y Onda (Variations y Wave).

Variaciones
Hay dos tipos de variaciones a elegir:

Random - Los campos crearan formas y formaciones aleatorias.
Uniforme - Los campos crearan formas y formaciones uniformes.

Puede seleccionar el Numero de variaciones que afecta el nUmero de variaciones que se
creardn en la escena. Ademads de afadir variaciones, también puede escalarlas. La escala afecta
la posicién de cada variacién: cuando se establece en valores bajos, las variaciones se
acercaran mas entre si. Cuando la escala es mayor, la distancia entre cada variacién sera
mayor.

Ejemplos de variaciones random y uniformes:

Uniform with scale at 10 | Uniform-with scale at 15

Onda

Hay cinco tipos diferentes de olas para elegir:

Ningun - No se utiliza ningin modificador de onda.
Circulo - Onda circular.

Cuardado - Onda cuardada.

Vertical - Onda vertical.

Horizontal - Onda horizontal.
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Ejemplos de tipos de onda:

“Cirele— : Vertical Horizontal

Ajuste la Frecuencia de las ondas, o en otras palabras, la velocidad a la que se repiten las ondas
en la escena. Elija la intensidad de las olas con el control de Amplitud. La amplitud representa
la mitad de la distancia entre los valores minimo y maximo de la onda.

Ejemplos de un modificador de onda cuadrada con diferentes ajustes de Frecuencia y
Amplitud:

4

ey

Square wave, F: 10 A: 50

; \ .
Square wave, F: 10 A: 100
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6. Interpretar Vista Previa de Animacion

Para comprobar como se vera la animacion, puede utilizar el botén Interpretar animacion en el
panel de Escena. No tiene que renderizar la vista previa de la animacién antes de ejecutar la
Interpretacion final. Funcidn Interpretar animacion sélo sirve para propdsito de vista previa.
Con Raster establecido en 1, la interpretacidn sera mas suave, la imagen sera de mayor calidad,
pero también tomard mas tiempo para procesar la animacion. Establezca Raster a 8 para
obtener la interpretacién mas rapida con una vista previa de baja calidad.

Los fotogramas que ya se han representado en la vista previa de animacién estan marcados
con verde en la linea de tiempo.

Nota: La interpretacion es una operacion de cdlculo intensivo. Cuando tiene muchas claves y
fotogramas configurados, la interpretacion puede tomar mucho tiempo. Le sugerimos que
configure Raster a valores mds altos para obtener la apariencia aproximada de animacion
mucho mds rdpido. La calidad de la vista previa de animacion no corresponde a la calidad del
Interpretacion final.

7. Interpretacion Final

Cuando esta satisfecho con la animacidn, seleccione desde Menu: Escena -> Interpretacion
final (Scene -> Final render).

Seleccione ubicacién, nombre de archivo y formato de archivo como una secuencia de
imagenes en .jpg, .png, .bmp, .tif o como un video en formato .avi, .mov, . mkv o .webm.
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Final Render

Path D:/GRAPHICS/.../bestof/amber projects
Filename anim png

anim.0001.png

Frame # padding

Animation ext name.#.format

Start frame

End frame

5000

Render

Cancel

Para la secuncia de la imagen, ajuste el relleno
del fotograma (frame padding) y la extensién de
la animacion.

Elija el fotograma de inicio, el fotograma final y el
numero de pasos de interpretacion.

Haga clic en Interpretar (Render) para iniciar la
interpretacion final o en Cancelar (Cancel) si no lo
desea.

Haga clic en Aplicar (Apply) para aplicar los
cambios.

Puede crear animaciones desde la secuencia de
imagenes utilizando otras aplicaciones.
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&) Final Renq Para el video, ajuste fotogramas por segundo

(frame rate) en FPS. Seleccione el codec para el

Path D:/GRAPHICS/.../bestof/amber projects formato de video:
Filename anim / .avi: h264, huffYUV (compresidn sin pérdidas)
anim.me .mov: h264, h265
.mkv: h264, h265, huffYUV (compresién sin
Frame rate , .
S pérdidas)
O Basic .webm: VP8
@) Advanced
Profile | {Eai Level Elija entre ajustes de calidad basicas o avanzadas.

Bitrate encoding VBR, 2 pass

Basico: establezca la calidad en %. Cuanto mayor

Target bitrate [Mbps]

Maximiim bitrate (Mbps]. [ 5 sea la calidad, mayor sera el archivo.

L] Keyframe distance Avanzado: establezca los ajustes avanzados para
[J Lossless ; . . . .
el cédec seleccionado, incluido profile, level,

bitrate encoding, target / maximum bitrate and
Start Frame

keyframe distance.

End frame

Compruebe la compresién sin pérdida si desea

i E500 que el video original y descomprimido sea

idéntico.

Render

La opcidn de compresion sin pérdida no estd
disponible para el cédec VP8.

Estos ajustes son para usuarios avanzados que
estan familiarizados con los cédecs H.264, H.265 y
VP8.

Elija el fotograma de inicio, el fotograma final y el
numero de pasos de interpretacion.

Haga clic en Interpretar (Render) para iniciar la
interpretacion final o en Cancelar (Cancel) si no lo
desea.

Haga clic en Aplicar (Apply) para aplicar los
cambios.

Cuando se inicia la interpretacidn final, la aplicacién calcula el tiempo estimado del render:

1/20 (Frame #1)

Estimated: 00:09:56 Total: 00:00:17 0

0%

Cancel

31



Nota: Cuantos mds pasos se establecen para interpretacion final, mds tiempo es necesario para
interpretacion la animacion final. Las animaciones grandes pueden tomar incluso pocas horas.
Le sugerimos que realice tales animaciones cuando no utilice su computadora activamente, por
ejemplo durante la noche.
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Crear, Cargar y Guargar Escenas

Crear Nueva Escena

Para crear una nueva escena, seleccione la opcién Nueva... en el Menu de Archivo. Al hacer
esto, ventana de Nueva escena aparecera. Esta ventana le permite ajustar el tamafio de la
nueva escena y configurar los ajustes que va a utilizar. En seccién ‘Informacidn sobre Tamafio
de Imagen’ (‘Image Size Info’) puede comprobar el tamafio de impresion de la imagen en DPI.

Puede elegir entre variedad de ajustes de tamafio de la escena o agregar / eliminar ajustes

preestablecidos usando los botones @/@
Ajuste la velocidad de reproducion en FPS y repeticién de reproducién (looping).

Puede seleccionar el color del fondo seleccionando Custom... en un mendu. La eleccidn del
fondo Negro, Blanco y Ninguno (transparente) preestablecido estd disponible también.

Haga clic en OK para crear una nueva escena o Cancelar, si no lo desea.

Abrir Escena

Para abrir una escena, seleccione la opciéon Abrir... en el Menu de Archivo. Este panel le permite
abrir una imagen (PNG, JPG, BMP, TIFF) o imagen previamente guardada (en formato AMB) y
ajustar los propiedades. Al abrir de imagen previamente guardada, la imagen sera interpretada
de nuevo.

Por ultimo, haga clic en OK para abrir la imagen, o Cancelar, si no lo desea.
Para abrir una imagen recientemente guardada, seleccione la opcién Abrir Reciente en el

Menu de Archivo. Esta opcidn le permite seleccionar una de las ultimas imagenes guardadas en
formatos de archivo .amb, .png, .jpg, .bmp v .tif.

Guardar Escena

Para guardar la pintura, utilice la opcién Guardar... en el Menu de Archivo. El formato nativo es
formato de archivo AMB, que contiene toda la informacidn acerca de la imagen y las capas.
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Utilice este formato si desea editar la escena mas tarde. Al abrir de |la escena previamente
guardada, la escena serad interpretada de nuevo.

Le recomendamos que guarde su trabajo periddicamente para evitar cualquier problema,
mientras que acostumbrarse a un nuevo software.

Si desea guardar la escena con los ajustes especificas o en forma que puede ser leida por otras
aplicaciones, utilice la opcién Guardar Como... del Menu de Archivo. Le permite guardar la
imagen en el formato PNG, JPEG, BMP o TIFF.

Nota: Por favor, tenga en cuenta que solo el archivo AMB contiene toda la informacion de
imagen. Archivos PNG, TIF y BMP guardan solamente la informacion sobre el color y la

transparencia. La transparencia no se guarda en el formato JPG.

Por ultimo, haga clic en OK para abrir la imagen, o Cancelar, si no lo desea.

Cerrar Aplicacion

Si desea cerrar una aplicacién, se puede elegir entre las siguientes opciones dependiendo de su
sistema operativo:

Usuario de Windows Usuario de Mac OS
- haga click en Archivo -> Quitar, o - haga click en Archivo -> Quitar, o
- presione un botén Cerrar en la esquina - presione un botdn Quitar en la esquina
superior derecha de una aplicacién o superior derecha de una aplicacién o
- utilice el atajo Ctrl+W o Alt+F4 - utilice el atajo Cmd+Q

Nota: Por favor no se olvide de guardar su imagen antes de cerrar una aplicacion.
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Publicar Imagen a Galeria

Crear una Cuenta de Galeria

Para publicar sus pinturas, en primer lugar hay que crear una cuenta. Para crear una cuenta,
tiene dos opciones:

De aplicacidn:

Crea tu Cuenta de Galeria desde el Menu de Amberlight: Archivo -> Preferencias de Publicar
(File -> Publish Preferences). Elija Su Nombre, Correo Electrénico ("Su ID") y la Contrasefia para
la galeria y, opcionalmente el enlace a su Pdgina Web.

De web:

En Pagina web de |la Galeria haga click Inicio de sesion -> Crear cuenta (login -> Create
Account) e introduzca "Su ID" (correo electrénico de su registracion).

Le enviaremos una Contrasefia, que se puede cambiar mas adelante.

Publish image from Amberlight to Gallery

Para publicar su imagen, utilice la opcién Publicar... en el Menu de Archivo. Introduzca el
Nombre de la Pintura, un Descripcion y Etiquetas de Pintura. Haga clic en el botén Publicar
(Publish). Su pintura sera publicada en la pagina web de la Galeria
(www.escapemotions.com/gallery), donde puede editar las imagenes mas tarde.

Editar su perfil y imagenes en la Galeria

Si ya ha creado una cuenta, vaya al sitio web de Galeria, pulse Login / Iniciar session
eintroduzca"Su ID" y la Contrasefia / Password.

En la seccidn Edit Pictures / Editar imagenes se puede editar el nombre de las imagenes,
descripcidn, etiquetas y otros ajustes.

En la seccién My profile / Mi perfil puede cambiar su Contrasefia.

Nota: Solo imdgenes se pueden publicar en nuestra Galeria en linea. Para compartir un video,
subadrtelo a los sitios web de videos compartidos de Youtube o Vimeo.
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Atajos de Teclado

New... / Nuevo...

Open... / Abrir...
Save / Guardar

Save As... / Guardar Como...
Quit / Quitar

Import Image... / Importar Imagen...

Publish Image... / Pulicar Imagen...
Preferences / Preferencias

Undo / Deshacer
Redo / Rehacer

Copy Field Properties /

Copiar Propiedades de Campo
Paste Field Properties /

Pegar Propiedades de Campo
Duplicate Fields / Duplicar Campos
Select All Fields /

Seleccionar Todos Campos

Delete Fields / Eliminar Campos

Scene Settings... / Ajustes de Escena

Edit Mode / Modo de Editar
Pan Selected Fields /
Desplazar Campos Seleccionados

Scale Selected Fields /

Escalar Campos Seleccionados
Rotate Selected Fields /

Rotar Campos Seleccionados

Increase Value +1 / Aumentar el Valor +1
Decrease Value -1 / Disminuir el Valor -1
Increase Value +10 / Aumentar el Valor +10
Decrease Value -10 / Disminuirel Valor -10

Move Scene / Mover Escena

Previous Keyframe /
Fotograma Clave Anterior
Next Keyframe /

Windows

Ctrl+N
Ctrl+O
Ctrl+S
Ctrl+Shift+S
Ctrl+Q
Ctrl+l

Ctrl+pP
Ctrl+,

Ctrl+Z
Ctrl+Shift+Z
Ctrl+C

Ctrl+V
Ctrl+D

Ctrl+A
Del

Ctrl+E

Mac OS

Cmd+N
Cmd+O
Cmd+S
Cmd+Shift+S
Cmd+Q
Cmd+l
Cmd+P
Cmd+,

Cmd+Z
Cmd+Shift+Z
Cmd+C

Cmd+V
Cmd+D

Cmd+A
Del

Cmd+E

Boton izquierdo del ratén (LMB)

Shift + LMB
Ctrl + LMB

Up
Down

Pg Up
Pg Down

Shift + LMB
Cmd + LMB

Up
Down

Pg Up
Pg Down

Botdn derecho del ratén (RMB)

Ctri+Left
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Fotograma Clave Siguiente

Previous Frame / Fotograma Anterior
Next Frame / Fotograma Siguiente
Play / Stop / Reproducir / Detener

Add Keyframe /

Agregar Fotograma Clave
Remove Keyframe/
Eliminar Fotograma Clave

Zoom In / Aumentar

Zoom Out / Reducir

Zoom 100% / Acercar 100%

Zoom In | Out / Aumentar | Reducir
Fit to Screen / Encajar en Pantalla

Help / Ayuda

Ctrl+Right
Left
Right

Del

Ctrl + +
Ctrl + -
Ctrl+0

Escpaciador

Cmd+Right
Left
Right

Del

Cmd + +
Cmd + -
Cmd+0

Desplazamiento o Desplazamiento + Alt

F1
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Derechos de Autor y Créditos

Amberlight © 2013-2017 Escape Motions, s.r.o.
Amberlight © 2009-2012 Peter Blaskovic¢

Escape Motions Equipo:

Peter Blaskovi¢, Michal FapSo, Lubos Toth, Miroslav Sedlak, Anton PoZivenec, Veronika
Klimekova, Andrea Hornakova, Jaroslav Kasa

Agradecimientos especiales a:

Todos aquellos, que contribuyeron con ideas, sugerencias, o ayudaron a finalizar Amberlight,
especialmente a Mark Schafer, Shannon Hoppe, Casey Herbert, Tomas Lancz and Rastislav
Piovardi.

Traduccidn y correcciones: Tanya Hayman, Veronika Klimekovd, Marta Fernandez, Andrea
Hornékova, Irene Briz.

Iconos de la Interfaz de Usuario: "Batch" by Adam Whitcroft

Bibliotecas & Herramientas:
Esta aplicacion ha sido desarrollada con las siguientes bibliotecas:

Qt 4.8 - LGPL license (2.1) - http://gt-project.org/downloads/
QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/

CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/

FFmpeg with libx264, libx265 and libvpx - https://www.ffmpeg.org/
H.264/AVC license by MPEGLA - http://www.mpegla.com
H.265/HEVC license by MPEGLA - http://www.mpegla.com

La lista completa de licencias esta disponible en la carpeta de instalacion: Amberlight 2 /
Licencias.

Gracias a Dios por todas las ideas creativas.
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Amberlight End-User Software License Agreement

Copyright 2013-2016 Escape Motions, s.r.o. All Rights Reserved.
Copyright 2009-2013 Peter Blaskovic. All Rights Reserved.

This license is a legal agreement between you and Escape Motions for the use of Amberlight
software (the "Software"). By downloading, installing, copying, or otherwise using the
Software, you acknowledge that you have read terms and conditions of this license,
understand them, and agree to be bound by them. If you do not agree with these terms and
conditions, Escape Motions is unwilling to license the Software to you, and you are not
authorized and may not use the Software.

Permitted Use

You may install the Software on multiple computers provided that not more than one of those
computers is in use simultaneously and that those computers are solely for your own personal
use.

The Software may be installed on a computer that is for multiple users but it may not be
installed on more than one computer regardless of whether those computers are operated
simultaneously or not.

Users may use the Software for commercial, or for-profit activities as well as for personal, non-
commercial, or non-profit activities.

You may not remove the copyrights notices from the Software. You may make one (1) copy of
the Software for back-up or archival purposes.

Restrictions

This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law
and international treaty. This is a license, not a transfer of title, and unless you have been
granted prior, written consent from Escape Motions you may not:

a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.

b, Sell, rent, lease, assign, or sublet the Software or portions thereof.

¢, Grant rights to any other person.

d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the
Software or the documentation in whole or in part.

e, Use the Software in violation of any international law or regulation.

You must not intentionally or unintentionally make the Software available on any web server,
ftp server, file sharing network, shared directory, or other location where any other person can
acquire a copy of the Software. You are responsible for keeping the Software safe from being
copied by others.
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Display of Copyright Notices
All copyright and proprietary notices and logos within the Software files must remain intact.
Indemnity

You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your
use or misuse of the Software, or a violation of any terms of this license.

The Software may contain technical inaccuracies or typographical errors, so changes and/or
updates may be affected without notice. Escape Motions may also make improvements and/or
other changes to the Software at any time without notice.

Disclaimer Of Warranty

THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO,
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT
THAT THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.

H.264/AVC and H.265/HEVC License Notice

To the extent that the Software contains AVC and HEVC encoding and/or decoding
functionality, commercial use of AVC and HEVC requires additional licensing and the following
provision applies: THE AVC AND HEVC FUNCTIONALITY IN THIS PRODUCT IS LICENSED HEREIN
ONLY FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO ENCODE VIDEO IN
COMPLIANCE WITH THE AVC AND HEVC STANDARD ("AVC VIDEO" / “HEVC VIDEO”) AND/OR
DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND
NON-COMMERCIAL ACTIVITY AND/OR AVC AND HEVC VIDEO THAT WAS OBTAINED FROM A
VIDEO PROVIDER LICENSED TO PROVIDE AVC AND HEVC VIDEO.

INFORMATION REGARDING OTHER USES AND LICENSES MAY BE OBTAINED FROM MPEG LA
L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Limitations Of Liability

YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH
THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS.
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